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If you are reading this in a media centre during the G8, there should (hopefully!) 
be a companion CD-ROM to this manual, which will have all the necessary 
installation and zip files which are mentioned within. If in doubt, ask around for 
help, anyone will be more than happy to help you out and give you advice, or 
point you in the direction of someone that can! 



1. Introduction 
 
Welcome! This guide is intended to help you convert and upload your videos, in 
common compressed formats, to websites where other people can download the footage 
and view it on their own computer, or use it themselves for video documentaries that 
they wish to create themselves. It is a part of a decentralised video-sharing initiative 
that will allow people to construct their own stories of the 2005 G8 summit in 
Gleneagles in Scotland. 
 
This guide assumes a certain amount of knowledge on the reader’s part of basic 
technical skills with using a camcorder. The guide has been written with the Mini DV 
video format in mind, simply because at present this is the format which is used by the 
vast majority of camcorder users (and because it’s the only one I am familiar with!!).  
 
The guide does not go into capturing your footage from a video camera onto a 
computer. Each camera will have different settings and software needed for this. If you 
have a Mini DV camera, more than likely it came with a CD-ROM installation disc. You 
should bring this with you if you are using other computers than your own. It contains 
software called drivers which help a computer to communicate with the camera. You 
should install these first before attempting to capture footage onto a computer. In most 
cases as well, the software that comes with the camera should facilitate the capture of 
video footage, and possibly even a small degree of editing. 
 
In most cases, your camera will have a firewire port, also known as IEEE 1394 or I-
link. You will need a firewire port (and a firewire cable) to connect your camera to the 
computer. You should refer first to the manuals that came with your hardware to set 
this up. 
 
There are several free programs available for capturing your footage if you are using a 
MiniDV camera. The best is WinDV and can be downloaded from 
http://www.videohelp.com/tools. It works on the simple premise of pressing 
‘record’ on your computer, and pressing ‘play’ on your video camera, similar to when 
you used to copy cassettes with a double deck back in the day… 
 
The guide does not go into editing processes, due to time & space constraints. A basic 
video editor will allow you to cut up, move, and join together your video files. Popular 
commercial examples of such software are Adobe Premiere and Final Cut Pro, while 
AVCutty is a free shareware editing tool. For more information on freeware editors, you 
should again visit the excellent Videohelp website (http://www.videohelp.com) and 
go to the Tools section. AVCutty will allow you to chop up your video files, rearrange 
them, and put back together in a different sequence. It does not offer more advanced 
options like adding in music or special effects, but for beginners on a zero budget it is a 
good introduction to the fundamentals of editing. 
 
What this guide will do is take you step by step through several different options of 
encoding and uploading your video. We’ll start with compressing the footage into 
popular encoded formats, then look at three possible locations where we can store the 
finished output, and then you will find information on where you can get this software 
easily, and how to fully install everything you need. If you are unfamiliar with the 
software and codecs used in the guides, you may wish to read Section 7 first. 
 
 



2. Converting video footage to DivX or XviD for web publishing with Virtual Dub 
 

OK so we’re going to use a piece of free software called Virtual Dub to compress our 
video down into a much smaller filesize. At the moment, the uncompressed MiniDV 
footage that you’ve captured onto your computer takes up 3.6 Megabytes of data per 
second, which works out at 216 MB per minute, or a massive ~12.5 Gigabytes per hour. 
This is a huge amount of data, and it is far too large for people to download off the 
internet, even with the fastest broadband connection available. 
 
Using different free video and audio codecs, we’ll compress our raw video footage down 
considerably to a manageable size, so eventually we will be able to upload it to a web 
server for others to download to their own computers and watch. A video codec is a 
device or software module that enables the use of compression for digital video. The 
word codec comes from either "Compressor-Decompressor" or "Coder-Decoder," which 
describes a device or program capable of performing transformations on a data stream 
or signal. Codecs can put the stream or signal into an encoded form (in this case, our 
nice and small video file). The Codec can also be used for watching the compressed 
video, i.e. decoding it into a viewable format so other people can see it. 
 
First of all we’ll launch Virtual Dub version 1.6.5. This version is able to handle MiniDV 
footage for processing. So, click Start -> Programs -> Virtual Dub. If you cannot find 
a shortcut for it in your Start menu, location the Virtual Dub folder in the C:\Program 
Files folder, and then double click VirtualDub.exe to start the program running. You 
should now have the Virtual Dub Window open on your computer, like so: 
 

OK so now we have our 
program running. What 
we’re going to do is open up 
the MiniDV file in Virtual 
Dub, apply a few filters to 
our footage to clean it up a 
bit, and then transform it 
into a much smaller file 
using the DivX or XviD 
codec for the video, and 
the Lame MP3 codec for 
the audio. 
 
In Virtual Dub, I’m going to 
click on File -> Open 
Video File and pick a file I 
have saved on my hard 
drive called 
ProtestFootage01.avi   
This short piece of footage I 
am using as an example 

here is only 30 seconds long, yet it is taking up nearly 110 MB of space on the hard 
drive. Virtual Dub will then open the file and you can see the first frame of the footage  
in the window. 
 
You may notice that the picture is quite “jagged” or choppy. This is due to interlacing, 
which means that there are two fields of video information coming into the picture. I 
wont go into more detail about this, but we want to get rid of this for our web video. 

(the VirtualDub window) 



The first thing we want to do 
is load the Smart 
Deinterlacer Filter. To do 
this, 

1. Click Video 
2. Click Filters 
3. Click Add 
4. Scroll down to Smart 

Interlacer and Click OK 
5. Click OK again 

 
You should now be able to see 
the Smart Deinterlacer video 
filter loaded up into Virtual 
Dub. 
 
 
 
 
 
 
 
 
 
 

 
  

 
 
The deinterlacer filter has been loaded 
onto the video footage. This will stop it 
looking jagged when its converted. 
 
 
 
 
 
 

1. 3. 

Filter loaded. 

(interlaced footage) 



Next we’re going to compress the audio with the Lame MP3 audio codec. This will shrink 
down the eventual filesize considerably without much audible difference in the sound, 
especially for web video. 
 

1. Click Audio -> Full Processing Mode  
(When you click Audio again you should see a small dot next to Full Processing Mode) 
2. Click Audio (again) -> Compression. The audio compression dialogue box will 

appear. 
3. Click on Lame MP3. 
4. The MP3 encoding options will appear. You can choose what quality level you want 

to change the audio to. Bear in mind that the lower the quality, the smaller your 
converted file will be in the end. What you have to think about is who is going to 
be downloading the footage, and what sort of internet connection they will have. I 
usually choose a 96kbps CBR (Constant Bit Rate) setting. There is a slight 
noticeable difference for complex audio like music at this quality level, but for 
speech it is fine. I recommend that you experiment with the different settings, and 
find a level that you like best. Remember the trade off for better quality audio is a 
larger filesize. 

5. Click OK. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. 

2. 

3. 4. 

5. 



Next step is to prepare the compression for the video, using either the DivX or XviD 
codec. Whichever one you choose to use is up to you. Both codecs take the video and 
compress it down so the video does not look too pixelated, but at the same time 
substantially reducing the size of the video data. Compressing using the DivX codec is 
easier for beginners, it has less complex options to get caught up in, and compatibility 
with the codec is widespread; there are even commercial set-top players which connect 
to TVs, that can play CD-ROMs with DivX films burned onto them. The XviD codec is a 
bit more advanced, but it is generally agreed it looks better than DivX. Again, it is up to 
you which one you choose. Experiment and play around with all the settings. 
 
Compressing the video works in the same way as what we did with the audio.  
We’ll start with Option A for the video: DivX.  

1. Click Video -> Full Processing Mode 
(When you click Video again you should see a small dot next to Full Processing Mode) 
2. Click Video -> Compression 
3. Click DivX 5.x Codec 
4. Click Configure 
5. On the General tab, click Select DivX Certified Profile 
6. Select one of the profile. If it’s video for the web, then your best bet is probably 

the Portable profile. 
7. Click Next. 
8. Resize the video to whatever aspect you want. The bigger you make the video, 

the bigger the final filesize! Remember that the pixels should have a 4:3 ratio, so 
the width is ~1.3 times the height of the video. Otherwise your video will look 
skewed. 

9. Select a framerate. Same advice as before, the more frames, the bigger the file. 
If you drop some frames, the video may look jerky. 

10. Click Finish, and then OK. 
11. You should now be back in the VirtualDub window. 

 

 
 

 
 
 
 

1. 
2. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now we have to configure the settings for DivX… 
 

 

 
 

 
 
In the window on the left above here, you can see that DivX is giving you an option to 
change the bitrate. The bitrate means how many kilobits per second the video will 
consist of. It’s a slightly more advanced method, so if you are new to encoding with 
DivX just use the automatic method as described above, and move on. 

3. 

4. 

5. 
6. 

7. 

8. 
9. 

10. 



[Option B is to encode the video with the XviD Codec. Just repeat steps 1 and 2 
from the previous DivX option, and for step 3, choose the XviD MPEG-4 Codec instead, 

then click on the Configure button to bring up the 
different options available to you for encoding with XviD. 
 
You should now have the configuration window open. 
Here you can adjust the output size of the file with a bit 
more precision than the DivX option. You can slide the 
bar underneath the Target Quantizer to make a bigger 
or smaller file. By clicking on the Target Quantizer 
button, you are given the option of a Target bitrate 
instead. Again, here it is up to you to decide what trade 
off you are willing to trade between quality and filesize. 
 
Next to the Target 
bitrate option box, there 
is a small button marked 
‘calc’. If you click on this, 
a small bitrate calculator 

will appear. Here, you can type in the value of the length 
of your video footage, and a rough estimate of what you 
want the eventual filesize to be. In the lower section, you 
can also put in what format your audio is going to be in. 
From this, the calculator will give you a bitrate that you 
should adjust the Target bitrate to, in order to produce 
the file to your specified size. 
 
Once you have done this, click OK. I wont go into the 
Advanced Options here, but there are many different 
ways in which you can tweak your settings so your 
eventual footage will look slightly better. For short videos 
for publication on the web, this is not essential. If you have time, you should play 
around with the basic settings, and see what way your video turns out. 
 
While using the XviD codec, you may also 
need to resize your footage. This is done 
slightly differently to DivX. Once you have 
completed configuring the XviD compression 
settings, you go out back into the main 
Virtual Dub window, and click on Video -> 
Filters. Then Click Add and scroll down to 
the Resize filter. Here, you can type in 
whatever size you want to change the 
dimensions of the video footage to. 
Remember to keep it in a 4:3 aspect (e.g. a 
width of 320, a height of 240 pixels). Then 
click OK to bring you back eventually into the 
Virtual Dub window.] 
 
So now, you should have loaded your Smart Deinterlacer video filter, your Lame MP3 
audio codec, and either your DivX or XviD video codec, depending on whether you 
chose option A or B for video. We’re now ready to change it into a format ready for 
publishing on the web. 



Creating the output once we have everything loaded is simple! All you need to do is click 
File -> Save as AVI. An option box to save will pop up. You should name your file to 
correspond with the codec you have encoded with, for example: 
ProtestFootageDIVX.avi or ShutdownGleneagles_XviD.avi. That way other people 
who want to watch or maybe even edit your video will have a knowledge of what way 
the file has been encoded. Then click OK, and sit back and let Virtual Dub do the 
encoding.  
 
A small box will appear letting you know the 
progress of your encoding. In the box you will see 
the Total time estimated it will take to encode your 
video. This will depend on several factors – what 
bitrate or profile you have chosen for your video 
and audio, the length of your footage you are 
converting, and how powerful the computer you 
are working is. You may want to go and get a cup 
of tea or coffee. 
 
Hopefully everything will have worked out alright 
for you. If you get any error messages along the 
way, go back a few steps and check that you have 
set everything up alright.  
 
In these screenshot examples, I have ended up 
with an output DivX file of around 3.2MB, and an XviD file of around 4.5MB. My original 
piece of MiniDV footage was 30 seconds long, and that was over 105MB in size. So with 
resizing the footage, and compressing it with video and audio codecs, we’ve shrunk it 
down to around 25 times smaller than our initial file, while still being watchable to the 
person downloading it off the internet. 
 
A good place to go for support are the www.videohelp.com support forums. There are 
forums specifically devoted to encoding into DivX and XviD, where you can ask 
questions about your problems, which are usually answered by other helpful souls fairly 
quickly. You can also ask around the media centre for help, someone should be able to 
sort out any problems, or point you in the direction of someone that can. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3. Converting video footage to MPEG2 with Mainconcept Encoder 
 

The Mainconcept MPEG Encoder is a trialware program. This means that you can only 
use it for a certain amount of time before the features are disabled and you have to pay 
a fee for continued use. There are free MPEG encoder programs out there, but if you are 
new to video conversion, then this tool is the easiest to use for this job. 
 
1. Start up the Encoder: Start -

> Programs -> 
Mainconcept -> MPEG 
Encoder. The MPEG Encoder 
window will appear.  

2. Click the Open option next to 
the Video Source box. 

3. Choose the video file you 
wish to convert into an MPEG. 
The audio with your video clip 
will automatically open in the 
Audio Source box.  

4. The Output file will 
automatically be created the 
same name and directory 
location as the source file, 
except instead of a .AVI 
extension, it will have a .MPG 
extension (for MPEG video). If 
you wish, you can change the 
filename simply by typing it 
into the Output box. If you 
want to change the output 
directory, click on the Browse 
button and pick your location 
where the new file will be saved. In the example screenshots below, I’ve changed the 
name of the output file to SaturdayMarch_MPEG2.mpg so it will be easier for 
other people to identify what format the file is. 

5. Next we need to specify what kind of MPEG file we want to output. In the Output 
format options in the lower half of the Encoder window, click on the MPEG type 
drop down options. You will see a variety of different MPEG types there. Click on 
DVD. This is a special type of MPEG2 file which conforms to DVD standards.  

6. Click on the Stream type drop down options, and choose Program 
(Video+Audio). This means that our 
output file will contain both the video 
and audio in a single file, rather than 
two separate files. 

7. The Video mode should default to 
whatever the input mode was, i.e. if 
your video camera is a PAL video 
camera, then the output should be 
PAL too The Audio mode should be 
set at Layer 2.  

8. Next click on the Details button. 
This will bring you into the Detailed 
settings. 



9. Here we will deinterlace the video footage. In the Field encoding box, click Top 
Field First. 

10. In the Deinterlacing box, click Use Top Field. 
11. Underneath these options, you can see two slider bars, which are marked Search 

method and Search range. You can leave these somewhere in the middle. Click 
OK. 

12. You should now be back in 
the Mainconcept Encoder 
window. In the bottom left 
hand corner of the window is 
the Convert button. Once 
you have configured all the 
settings in the previous 
steps, click this. A little 
green progress bar will go 
across the bottom of the 
window. Next to this 
progress bar, you can see 
how the encoder is doing, 
with the time used up in the 
encoding process, and an 
estimated time left for the 
remainder of the encoding 
process. In this case, a 30 
second clip of footage is 
taking approximately 50 
seconds to convert, so if you 
have a lot of footage, you 
may want to go and get 
yourself a cup of tea or 
coffee. 

13. When the file is converted, the encoder will give you information on your new file, 
including the duration of the file, the time it took to encode, and down in the bottom 
right hand corner, an Estimated file size.  

 
Your new MPEG video file is now ready for DVD authoring. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4. Uploading to the internet with CCPublisher Tool to http://www.archive.org 
 

CC Publisher is a tool that does two things: it will help you tag your video 
files with information about your license, and it allows you to upload 
Creative Commons-licensed audio and video works to the Internet 
Archive for free hosting. You also have the option of publishing the 
licensed and tagged audio works on your own site. 

 
The first thing you will need to do is create an account on the Internet Archive. Go to 
the website at http://www.archive.org, and click on the “join us” link over on the right 
hand side of the page. Read down through the terms and conditions, and then enter a 
valid email address, with a password that you will use for accessing the Archive. Try to 
pick something simple as a password you will be able to remember in future. You must 
pick a “screen name” or nickname as well that will appear next to footage that you 
upload.  
 
You can then click on the “Get Library Card” button. You will then be given access to the 
Archive. A message should appear confirming this, and then you will be returned to the 
main Archive page. You can now launch the CCPublisher Tool application. 
 

Using CC Publisher 
 
Step one: Dragging your videos into CC Publisher: Start 
the CC Publisher application and hit Next on the introductory 
screen. The process starts by adding your files to be 
tagged/uploaded. You can use the browse function to find the 
files, or simply drag and drop as many files that you would 
like to license (all with the same license) and upload (all into 
the same collection at Internet Archive). 
 
 
 
 
 
Step two: Adding information about your works: The 
next screen will ask for information about your recording or 
video, which will help others find it at the archive and build up 
the metadata in your audio files. 
 
 
 
 
 
 
 
 
Step three: Choose your license: CC Publisher lets you 
choose one of several license types and the options for each. 
 
 
 
 
 



 
Step four: Logging into the Internet Archive: To upload 
your works to the Internet Archive, you'll need an account 
there to associate your files with. You should have this set up 
from the instructions above. If you don't have an account 
there, there is a handy button within CC Publisher that will 
launch a web browser and allow you to join it. 
 
 
 
 
 

 
 
Step five: Start your upload to the Archive: The final step 
is to upload your works to the Internet Archive. Depending on 
your connection and the size of files you are uploading, this 
step can take anywhere from a few seconds to several hours. 
 
 
 
 
 
 
 
 
Step six: All done!: When your upload is complete, the 
Publisher application will furnish you with a URL that should 
be live within 24 hours at the Archive. You can copy and paste 
this URL into your postings so people will be able to download 
the video, once the Archive administrators have approved it. 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



5. Uploading footage with FTP Explorer to the Global Indymedia Video site 
 
1. Go to http://video.indymedia.org and click on the Publish your video! Link in 
the top left hand corner of the screen. 
2. Read the instructions carefully, and then click on Continue to the next step. 
3. You will be issued with the FTP server address, a username, a password, and the 
port number to connect to. The username and password will probably be the same, 
and will take the format ivdn-x12y3z4. 
4. Start up FTP Explorer. Click 
on Tools -> Connect. The 
Connect dialogue box will appear, 
offering a few common FTP sites. 
Here click on the Add button, and 
type in the details of the FTP 
server that you were give on the 
video.indymedia.org site, 
including your login ID and the 
password, and the port number 
(usually 21). Give the details a 
profile name, such as IMC Video 
site, and then click Connect. You 
will then be connected to the 
video.indymedia.org FTP server. 
5. Click File -> Upload and pick 
the file on your computer you want to put up on the server. Make sure that your file is 
called something that describes what it is about, and possibly any compressed format. 
Click OK. 
6. Wait. 
7. Once the file has uploaded, go back into your web browser, and click on Continue to 
the next step. Close off FTP Explorer to disconnect from the video.indymedia.org FTP 
site. 
8. Hopefully if all has gone OK with the upload, you will be given the option to input a 
short description/details of your video, so people coming along to the site to download 
will know a bit about what it is they are downloading. 
 
Uploads to the Global Video site should be of good quality so that it is usable for 
independent TV-stations and public screenings. Should the video you want to have 
published be not so well coded, it is better to use a local IMC. Accepted uploaded file-
sizes to the site are between 20 MiB and 2 GiB. Accepted file-extensions are ogm, mpg, 
mpeg, mp4, rm, avi, mov, divx, vob and dv. 
 



6. Creative Commons Licensing 
 
Creative Commons 
defines the spectrum of 
possibilities between full 
copyright — all rights 

reserved — and the public domain — no rights reserved. The CC licenses 
help you keep your copyright while inviting certain uses of your work — a 
"some rights reserved" copyright. Creative Commons is a new system, built 
within current copyright law, that allows you to share your creations with 
others and use music, movies, images, and text online that's been marked 
with a Creative Commons license. 
 
Creative Commons is a non-profit corporation founded on the notion that 
some people may not want to exercise all of the intellectual property rights 
the law affords them. Many people have long since concluded that all-out 
copyright doesn't help them gain the exposure and widespread distribution 
they want. Many entrepreneurs and artists have come to prefer relying on 
innovative business models rather than full-fledged copyright to secure a 
return on their creative investment. Still others get fulfilment from 
contributing to and participating in an intellectual commons. For whatever 
reasons, it is clear that many citizens of the Internet want to share their 
work -- and the power to reuse, modify, and distribute their work -- with 
others on generous terms. Creative Commons intends to help people 
express this preference for sharing by offering the world a set of licenses on 
their Website, at no charge. 
 
This means that other people can use your G8 footage and incorporate it 
into their documentaries; and vice versa, likewise you can do the same – if 
you assign it a Creative Commons license. Other people may use and adapt 
it, as long as they observe the conditions of the license, e.g. they cannot 
copyright it for themselves, or use it for money-making purposes. In this 
way, we will all be able to share in one another’s footage, and create 
documentaries ourselves, distributing information and films at a highly 
localised and democratic level! Most footage on video.indymedia.org and 
the Internet Archive is either licensed under Creative Commons, or public 
domain. 
 
Please share your footage with others via whatever means you can, via the 
internet or physical tape/disc swapping, and encourage others to 
reciprocate the gesture. Indymedia is not about media as an ego-booster or 
a career path, it is about creating open and democratic media which covers 
events and opinions that are not covered elsewhere. 
 
 



7. Downloading and Installation 
 

To download a file, you should just click on it and your browser 
(http://www.getfirefox.com – go and get Firefox if you are using Internet Explorer and 
replace it immediately with Firefox!!) will offer you the option of opening it or 
saving it to a file. I recommend that you create a new folder or directory on your 
computer called “Video Tools” or something similar to download all the installation files 
into, so you will have a copy of them in case you need to re-install them at some later 
point, or maybe share them with a friend. 
 
You should first of all go to 
http://www.winzip.com and 
download the excellent Winzip 
program. This is used to compress 
files so they take up less space for 
downloading. Go to the 
downloads section, and download 
the Evaluation Version (i.e. free!) 
of Winzip 9.0. This will save a file called Winzip90.exe or Winzip90-SR-1.exe onto 
your computer. When the file is fully saved, double-click it to start the installation 
process. Then Click on Setup and follow the instructions to set it up. Winzip will then be 
installed on your computer. This means you will be able to open up all files with the .zip 
extension at the end of them. 

 
Next we’ll install the codecs we need. Go 
to the website http://www.divx.com 
and go to the downloads section. Scroll 
down until you see the DivX Codec 
option. Click download, and save the file 
onto your hard drive. It will be called 
something like DIVX521XP2K.exe. 
Double click on this when you have it 
saved it, and this will start the installation 
process. Just click all the way through 
this. If prompted for the option of 
DivXPro, just say no. Once you have 
clicked Next, and accepted the licensing 
agreement, the DivX Codec and Player will 
be installed on your computer.  
 

Next go to http://www.koepi.org/xvid.shtml 
and go to the downloads section. Locate the XviD 
Codec option, and download it onto your hard 
drive. It will be called something like XviD-1.0.3-
201.exe. Double-click on this when you have 
saved it, and this will start the installation 
process. Just click OK and Next through this 
process, and once you have accepted the 
licensing agreement, the XviD Codec will be 
installed on your system (along with a few other small useful tools, which you may come 
around to using at some point later on when doing slightly more advanced video 
compression and conversion). 



Next go to http://www.videohelp.com/tools and click on Audio Encoders. Locate 
the Lame MP3 Encoder and save it to your hard drive. This will probably be a .zip file 
and may be named something like lame-3.96.1.zip. This is a zip archive file, so we 
need a place to unzip it to. First of all create a new folder in your C:\Program Files 
directory, and call it Lame MP3 (File -> New Folder -> (Lame MP3) in Windows 
Explorer, in the right directory).  
 
Next you need to unzip the file you 
downloaded. If you double click on the 
file, this should open up Winzip (if 
prompted to do so, click on ‘Use 
Evaluation Version’ when Winzip opens 
up), and you will be able to see a list of 
the compressed files contained within. 
We need to Extract these into the new 
folder that we created, i.e. 
C:\Program Files\Lame MP3. First 
we need to select or highlight all the 
files, you can do this by pressing Ctrl-A. 
Next we need to click on the big 
‘Extract’ button at the top of the Winzip 
window. An option box will appear 
asking you where you want to extract 
the files to. Pick the C:\Program Files\Lame MP3 directory that you created earlier, 
and click on Extract to unzip all the files. This should only take a second or two.  

 
Next you need to locate the C:\Program 
Files\Lame MP3 folder and open it up. 
There should be a new folder within this 
called ACM. Open this up. There should be a 
file within the ACM folder called 
LameACM.inf. Right-click on this file, and 
then click Install. This will install the Lame 
MP3 codec on your computer. 
 
(If you are using Windows XP then you 
might be warned that the software you are 
installing has not passed XP testing – ignore 
this warning and continue anyway). 
 
OK so we now have our DivX, XviD and 
Lame MP3 codecs for video and audio 
compression installed onto our computer. 
 

You should now also (hopefully) be familiar with the processing of unzipping a Zip file, 
i.e. opening it up, selecting all the files, and extracting them into a new directory that 
you have created. You can use this method for all unzipping actions needed with .zip 
files. 
 
If in doubt, don’t be afraid or embarrassed to ask someone for help! 
 
 



Next we’ll install Virtual Dub. Go to 
http://www.virtualdub.org and go 
to the downloads section. Choose the 
1.6.5 version and download it onto 
your computer. This file will be named 
something like VirtualDub-1.6.5.zip. 
Again, we’ll use the same process we 
used for unzipping the Lame MP3 
encoder. Double-click the file to open it 
up in Winzip, and then Extract all the 
files into a new folder called 
C:\Program Files\VirtualDub. 
Winzip will unzip the files. You can then 
go into the new folder you created, 
where there should be a file called 
VirtualDub.exe (an application file). If you double-click on this, this will launch the 
program. Job done! (You may want to create a shortcut on your desktop to this location 
so you can access it easier.) 
 
We also want to get the Smart Deinterlacer filter for deinterlacing our MiniDV 
interlaced footage. Go to http://www.videohelp.com/tools and locate the 
VirtualDub Tools section. Here you will find the Smart Deinterlacer filter. This will 
more than likely be a .vdf (Virtual Dub Filter) or a .zip file. You need to place (or 
extract from the zip file) the .vdf file into the C:\Program Files\VirtualDub\plugins 
folder, so the next time you launch VirtualDub, it will recognise the new Smart 
Deinterlacer filter. 
 
Next we’ll get the MPEG Encoder. Go to http://www.mainconcept.com and find the 
downloads section. Click on the MPEG Encoder and download it. You may be prompted 
for an email address if you want to download it, you can put in your real email address 
here if you want (they don’t send spam or pass on your email address) but if you don’t 
want to give it over, then put it any old address. An option box will then pop up asking 
you where to save the installation file. This will have something like the name 
mpegencoderv1.4.2.exe, save this onto your hard drive, and then double-click it to 
start the installation. As this MPEG Encoder is a trialware program, when you encode 
your footage into MPEG2 with it, it will leave a small watermark in the corner of your 
footage, until you purchase a serial number from Mainconcept. When you install it 
initially, you will have to put in the serial number as ‘DEMO’. Once you have entered a 
proper serial number, the watermark will be gone. 
 
Next we’ll get FTP Explorer. Go to http://www.ftpx.com and go to the download 
section. Download the FTP self-extractor onto your computer. This will have something 
like the name FTPExplorer.exe. Double-click this when you have it downloaded and it 
will install the program on your computer. 
 
Go to http://sourceforge.net/projects/cctools to download the CC Publisher Tool. 
Scroll down to CC Publisher and click download. Click on the .msi option if you are 
downloading for Windows. You will then be asked to pick a download mirror to get the 
installer from. Pick the one that is closest to you, and then click on the small download 
icon next to the location. It should then start the download, pick a location on your 
computer to save it to. Once this is finished, double-click the file to start the installation 
process. 
 


